
 

 

 
Instructions 

Getting Started 
 

 
 
 
SUNRISE Contacts 20171 is your personal electronic organizer for 
managing just about every kind of visual and auditory information in 
existence. Built on Apple’s highly acclaimed FileMaker Pro 16 platform, 
SUNRISE developers have created and designed this tool (used by various 
researchers) with your privacy in mind as well as provide the security your 
data deserves. 
 
How SUNRISE Contacts 2017 works 
Lying at the heart of your organizer is the Contacts (contacts.fmp12) 
database.2 
 

 
 

                                                 
1  Latest version can be found at http://www.sunrisepage.com/. 
2  Opening SUNRISE Contacts 2017.app or SUNRISE Contacts 2017.exe will open contacts.fmp12. 



This is the place where you do all things relating to your contacts (i.e., a 
combination of individuals, organizations, or both). This means you can 
store and perform various tasks related to your contacts, including sending 
and receiving emails, creating and printing labels, preparing your calendar 
schedule of events and things to do, accessing the web, and even 
preparing invoices and orders for products you might sell to individuals. 
Also included are features to ensure information is clean and accurate and 
to save you considerable time in getting your information ready and 
accessible. 
 
In the business world, a Contacts database is called a contacts relationship 
management (CRM) system. In the personal world, a Contacts database is 
called an “Address Book”. 
 
About Lookup databases 
Also included with the Contacts database are various lookup databases. 
These are designed to expand the versatility and power of your Contacts 
database. They give you the opportunity to separate and focus exclusively 
on more specialized information relating to your work, hobby or other 
activities, or to help you organize and handle different situations with 
ease. 
 
For example, you can store videos you have downloaded from the internet, 
cooking recipes you have collected, great photography shots you have 
taken, or play your music collection of mp3 files in a more flexible and 
simple way. Or why not have lookups for determining the postcode, 
country international codes, figuring out the correct suffix of a person’s 
name etc? 
 
In the business world, the presence of lookup databases help to turn your 
CRM into a powerful master data management (MDM) solution. In the 
personal world, it simply means you have extra power at your fingertips. 
 
Where to find more lookup databases 
For a range of available Lookup databases, check out the SUNRISE website 
at http://www.sunrisepage.com/contacts/lookups.htm, or suggest your 
own for us to build for you. Alternatively, if you have built your own 
Lookup databases, these can be added and accessed through the Contacts 
database 
 
To add your own Lookup databases to the Contacts database: 
 

1. Choose “Access…” under the File menu (you must be logged into the 
database as the Owner). 

2. Navigate to the Lookup databases layout. 
3. Create a new record. 
4. Add a picture to represent your lookup database and the filename to 

help you and other users identify the database. NOTE: To access 
additional fields, press the Option key and click the field name 
headers. 

5. Add a brief description to help you and other users to understand 
the purpose and function of your Lookup database. 



6. Go to your Lookup Databases layout page (press Command or Ctrl 
8). You will see your Lookup database in the list, arranged in 
alphabetical order by database title. 

 
To hide lookup databases, you can use the Account Names field to 
selectively choose the user accounts that can view selected lookup 
databases. The default is "All". Or enter the account name(s) on separate 
lines for greater control. Alternatively, if you go into the Preferences 
section (under the Help menu), there is a Lookups button in Layout 
Settings. Click it to disable access to the Lookups for Guest users, or All 
users. 
 
Access to the contact layouts 
The best way to get to know all the essential layout groups in your 
Contacts database is to press Command (or Ctrl) followed by the number 
0. This is your Menu. 
 

 
 
From the menu, you can access the following layout groups: 
 
Command (Mac) or Ctrl (PC) 1: Address Book 
The Address Book is the place for all things relating to contact information, 
such as the names of individuals and organizations, email addresses, 
telephone numbers, etc. 
 
Command (Mac) or Ctrl (PC) 2: Calendar 
Create and organize calendar items (or tasks) by any category (e.g., 
memos, messages, to do, or even a project name for that matter) and 
subject (i.e. name of an individual managing the calendar items). Add tasks 
(or calendar items for each category. Add your own personal or corporate 
pictures and print a calendar booklet with shown to hang on a wall (or 
create a booklet), together with all calendar items clearly marked and 
color-coded by priority. 
 
NOTE: If contacts.fmp12 is registered (this will open up the lookup 
databases), you can also turn on the Clock display in Preferences section 
and all upcoming calendar items will turn into events. Then you can receive 



messages on the screen, or emailed to you (or whoever receives the 
calendar items) at the right times. 
 
Command (Mac) or Ctrl (PC) 3: Documents 
This is the place to create and store unlimited individual and organization 
electronic documents of virtually any size and type (you may even include 
pictures, movies and sounds of all file types). We recommend documents 
are stored in a single location outside the database and create reference 
links in the database to the documents. However, if certain documents are 
important, also store a direct copy within the database. You can go both 
ways. 
 
Command (Mac) or Ctrl (PC) 4: Labels 
Print your most common types of labels (most are for Avery paper), or 
suggest your own and we will incorporate it. Add your own graphic designs 
and add text to your labels for that professional touch. Information from 
your contacts can also be included. 
 
Command (Mac) or Ctrl (PC) 5: Email 
Use this to create, send and receive emails. 
 
NOTE: To send messages by email for calendar events, you will need to 
create an email account here. 
 
Command (Mac) or Ctrl (PC) 6: Web 
Access the web browser for viewing URLs directly within the contacts 
database. 
 
Command (Mac) or Ctrl (PC) 7: Notes 
Write notes. Unlimited subject and category ensures your notes will cover 
every conceivable situation. 
 
Command (Mac) or Ctrl (PC) 8: Lookup Databases 
Access and open lookup databases. 
 
Only accessible from the Menu layout: Finance 
The Finance layouts provide a means of organizing the products you sell, 
as well as handling the ordering process and preparing/printing invoices 
for your customers/clients. 
 
Only accessible from the Menu layout: Personal 
The Personal layouts allow for more detailed information relating to the 
individual. You can keep a record of his/her interests, extra photos, noting 
details of pets (and even print pet posters if you have lost a pet), creating 
links to family members, storing physical details that might be relevant to 
your line of business (e.g., modeling) etc. 
 
About the buttons and menu commands 
Naturally, we have provided some buttons and useful menu commands to 
help you navigate through the records, layouts and fields, as well as 
perform other essential functions on the records or in the actual data 
fields. For faster access to the more useful menu commands and buttons, 



try pressing certain key combinations. Don’t know which keys to press? 
Clicking on the menus and checking against the menu commands will give 
you a clue. 
 
A useful design feature 
This brings up another useful design feature of SUNRISE Contacts 2017. 
The type of buttons and menus you will see and their position will always 
be consistent in all the databases associated with this product. In other 
words, if the databases are made by SUNRISE, they will look the same and 
work in the same predictable and reliable way. This simple design 
consideration makes it easy for you and anyone using the databases to 
remember all the buttons and menus in all the databases. Feel free to try 
them out. The more you do, the easier it will be. And don’t worry about 
making a mistake. Where there is a chance for you to make changes to the 
data in the records of your database, you will be given the opportunity to 
cancel from whatever function you intend to perform. All other buttons 
and menus that don’t modify your data will perform in a safe and 
predictable manner. 
 
How to enter contacts 
 
1. The first port-of-call will probably be your Contacts layout (also 

called the Address Book). You need this layout to, well, add contacts 
by name and any organization associated with the individual. 
However, you do have the power to organize individuals by any 
number of subjects and categories you require for quicker and easier 
finding of contact records. Furthermore, you can re-use a contact in 
another category. And, you can add more information about how to 
contact your “contacts” through telephone, email, web and other 
means. Want to store a picture? No problems if it helps to put a face 
to a name. Just drag and drop a picture in the picture holder field 
(you really can’t miss it!). Also, if you ever need to delete a contact 
record in the Address Book, click the row and choose Delete record. 
The specific details relating to the individual and organization will be 
retained the next time you need to recreate the record. It is only 
when you go into the individual or organization ID layouts (in the 
List layouts) that any deleting of records will permanently remove all 
details related to the individual or organization throughout the 
database. However, in the Contacts layouts (the one with the 
category on the side), you can focus exclusively on creating the 
contacts (i.e., individuals and organizations) and linking them 
together. In fact, many other layouts are dependent on the 
availability of these contacts to work properly. So it is best to start 
from the Contacts layout and enter your contacts from there. 

 
2. In the Contacts layout, choose New Record (if there isn’t a record 

already created). This is to create a new subject for your contacts. 
 

3. If you have created a new record, type a subject name. This is your 
overarching “first-level” category system to help you get a feel of the 
general nature of all your contacts you will store in that record. If 
you feel certain contacts are very different to the subject matter you 



have created, just create another record and type the subject more 
suited to the contacts. 

 
4. Next, you will probably want to create more specific categories 

under the subject name (very useful if you have heaps of contacts 
but need to find a way to quickly find one a more contacts in a 
specific sub-group (i.e., the category itself). 

 
5. Before you create a new contacts record, it is a good idea to click on 

a category to “highlight” it. This will have the effect of turning the 
category field into a black box with white text. Now you are ready to 
create new contacts. 

 
6. Edit Mode might be turned off. For people with tablets who could 

accidentally touch a field and enter into it, this is a useful safety 
feature to prevent data from being modified. If you want to edit data, 
click the pencil icon in the navigation bar (it is situated on the far 
right) until it turns red. You will enable Edit Mode. It is at this point 
that each time you enter a field, the Touch Keyboard will appear for 
tablet users. For laptop users, just type the text into the fields as 
usual. 

 
7. With Edit Mode turned on, click on the simplified image of a person 

(basically two circles representing the individual’s head and body). A 
new contact record is created. 

 
8. Click into “Individual Name” and/or “Organization Name” and type 

away. In the case of the Individual Name, you will be taken to a more 
detailed popover where you can break up the name into first name, 
middle name, last name, prefix (in that order, since most people like 
to type the first name initially and choose whether or not to include 
a prefix for those who need it for business purposes) etc. You can 
press the TAB key to exit the current field and enter the next field. 
Keep pressing TAB key to get through all the fields, including 
organization details. Press Shift TAB keys to reverse the direction 
when going back to a previous field. 

 
9. Step 8 is useful if you are typing in a new individual and/or 

organization name for the first time. However, if the individual or 
organization already exists in the database, don’t bother about 
typing the full name again. A pop-up menu will show the names of 
all individuals or organizations stored in your database. All you have 
to do is choose the individual and organization you want. 

 
10. To enter more contacts, scroll down to the last portal row (or press 

the Option key and click into the category for quick access to the last 
portal row). Repeat steps 7 to 10 for each contact you wish to store 
into the database. 

 
11. When you are finished, turning off Edit Mode will automatically sort 

the rows of contacts by last name and protect the data from being 
accidentally modified. Then it becomes a simple matter of scrolling 



to find a specific contact you wish to see, knowing the individual is 
arranged in alphabetical order. 

 
12. Do you see a paperclip in the top right corner of the individual’s 

photo? Click it a number of times until a specific type of information 
is displayed for all the contacts (e.g., telephone number, email 
address, postal address etc). This helps you to focus on the 
information that is important to you and give you quick access to 
this information. 

  
Documents archive and creation 
The usefulness of your database increases with your Documents layout. All 
those pesky electronic files hanging around on your computer that are 
connected in some way to your contacts can be brought together quickly 
and efficiently. The file format doesn’t matter. This database thrives on 
handling Excel, Word, PowerPoint, and PDF files, as well as movies, sounds, 
images and much more. All you have to do is throw the files into the 
container field and let the database make the association between the files 
and your contacts (individual or organization can be selected to make the 
link). 
 
NOTE 1: For your Contacts database to store documents, you need to 
provide a category name and highlight the category just like in the 
Contacts layout 
 
NOTE 2: As an additional feature, press the Option key as you click on a 
category. You will be shown the last portal record in the Documents portal 
window. Very useful if you need to quickly reach the next empty record 
portal for adding a new document. Press Option key as you click the 
documents icon. You will access the place to store a reference link to a 
document stored externally. Otherwise, don’t press the Option key to store 
a copy of the document inside the database. For extra information about 
the nature of the document and/or how to print the document, enable Edit 
Mode and click the information icon that appears next to the document 
icon. Pressing the Option key as you click the icon gives access to how you 
wish the document to be printed. No Option key means you will access the 
general information about the document. 
 
NOTE 3: The document title will automatically be entered on importing a 
file based on the file name. Or enter a document title first before importing 
the file. Whichever is more convenient. 
 
NOTE 4: You can keep documents stored externally and make a link to the 
document within the database, or store the documents directly within the 
database. For the former, click the document icon, and choose the Stored 
Externally tab. Alternatively, press the Option key as you click the 
document icon. If you press Option key again and click an empty container 
field, you can select the document through the dialog box. Or else drag-n-
drop the document file into the container field. A reference path will be 
stored in the database, but not the document itself. If you would like to 
store another copy safely within the database, choose the Stored in 
Database tab. 



 
NOTE 5: Do you want to know where the linked document referenced by 
your database is located on your computer? Go into the Externally Stored 
tab. Do you see a document you want to find? Press Option and Shift keys 
together and click the document. The folder containing the document will 
open up. 
 
NOTE 6: Keeping a reference path to a picture, audio, video or document 
file in a container field helps to keep the database compact in size. It is 
also the safest approach when managing large numbers of files and large 
file sizes. This is especially true in the event where your database file may 
get corrupted, which is possible under OS X if you should accidentally run 
out of storage space (since Apple still does not properly test its products). 
Then you will not be able to extract the documents in a corrupted 
database. However, in a database that references files externally, any 
corruption to the database will not affect the files. And anyway, it will take 
more than 100 million reference links in your database to make it too big 
and increase the risk of running out of space on your storage device, which 
is unlikely you will ever exceed. Beyond that, when you do keep a reference 
path, remember to keep the file in the same location and don’t move it. 
Certainly you should not trash it. You need the file to be located where it is 
for the database to retain a link to the file. So before storing the reference 
path in your database, decide on a secure and reliable place to archive all 
the documents and use the database to create the reference paths to this 
location. 
 
Entering notes 
The Notes layout provides another level of flexibility. Enter large slabs of 
text for the individual or any topic, organized under any subject matter 
and categories you want. You have the flexibility to decide how you want 
the notes to work for you. Perhaps you want to use them as an electronic 
diary to store text for any day. Or maybe you only need to store general 
notes relevant to your work. Whatever the case, you control what happens 
to the notes for your line of work, or personal activity. 
 
NOTE 1: You can encrypt notes for that added level of security. If you do 
encrypt your notes, remember that all text styling (e.g., bold, italics, color 
etc) will be lost. 
 
NOTE 2: Pictures can be added to notes in the notes list layout. 
 
More about categories 
Have you noticed how much we have used subjects and categories in 
various layouts? There is a good reason for this. Categories (and subjects) 
are a powerful way of organizing and quickly finding information at the 
press of a category. As you have noticed, categories appear as a column of 
grey with white-border text boxes on the left side. Initially these may look 
a bit complicated, but they really are not. Imagine these boxes are like the 
pigeon holes you find in a post office. Instead of throwing in a parcel or 
envelope into a box, you will be throwing in a word or words into one or 
more of these boxes. When you enter word(s) into a box, you are 
effectively categorizing the record(s) under a broad term that best 



describes or summarizes the nature of your record(s). By clicking on this 
word or words in the category, all related records are found and shown 
quickly to the right of the layout. It is basically like doing a search or 
record find, except you don’t have to remember the specific word or words 
to find those records. They are already there in the category system. Just 
click the box containing the category word or words and the search for the 
records is done instantly. Easy. 
 
To give an example of the benefits of having a category system in place, 
you may decide to store the names of your sister, brother, uncle, aunt, 
father or mother or anyone in your family and how to contact them 
(telephone number etc.). But how do you grab all these records at once? 
Maybe you would like to send them all a Christmas card or letter but don’t 
want to be finding each record one-by-one to grab the relevant details? 
Well, just create a category called “family” into one of the boxes and click 
on the category to highlight it. All the records relating to “family” get 
picked out and grouped together as portal records which you can scroll 
down to see everyone and their details. 
 
To create a category, click into an empty category box (the first empty box 
is usually your best bet) and type away. Repeat for each new category. 
 
TIP 
If you create multiple category words and put a number or letter at the 
front of the category word, you can also give a sense of hierarchy to your 
groups of contacts. Categories are sorted in alphabetical order. So, it is 
possible to have the broadest descriptions at the top to the more specific 
toward the bottom. In that way, you can narrow down the range of records 
you need to find quickly. 
 
Creating priority records 
To specify the priority level for your record, click the Record Number. It will 
change color. Red is generally classified as high priority, orange is 
important, and green is low priority. 
 
Prioritizing a record in the above manner is similar to another feature 
called “Marking Records” (available under the Records menu), except 
prioritizing a record is designed to help you give a sense of hierarchy in 
the level of importance of your records through the three different colors. 
If prioritizing a record is not important but you need to highlight the 
record, use the Marking feature and choose Show in the Mark menu 
command to gather and present those marked records. 
  
Finding records 
Finding records is undoubtedly a crucial part of any database system. 
SUNRISE Contacts 2017 is no exception. When finding records, all you do is 
click the Find button (also available under the Records menu). The Find 
button is the largest button sitting in the middle of your navigation 
buttons. It shows a simplified image of a magnifying glass as a clue to its 
function. 
 
Next, type in some characters or word(s) in any or all of the fields in the 



layout. To refine the search further, it is possible another layout may have 
the field you want. To access this field, use the layout navigation buttons 
to help you move to another layout while in Find mode. 
 
When you have finished with typing, press the Enter (or Return) key. The 
database will find all the records matching what you have typed in the 
fields. 
 
NOTE: You can choose Add New Request under the Requests menu to 
create multiple find requests to run simultaneously under the same general 
search. For more sophisticated searching, you may want to use the 
following in your fields (available under the Insert menu during Find 
mode): 
 
For date or time fields 
 

/ /         today’s date 
 
?         invalid date or time 

 
For any field 
 

=        exact match 
 
“ ”      literal text 
 
*        zero or more characters 
 
@      one character 
 
@*    at least one character 
 
!        duplicates 
 
...       range 
 
= = field content match 

 
 
For number fields 
 

<         less than 
 
>        greater than 
 
>=      greater than or equal to 
 
<=       less than or equal to 

 
Automatic postcode lookup facility 
Allergic to lots of typing? Who isn’t? Fortunately SUNRISE Contacts 2017 
understand your concerns. 



 
For example, entering an organization name and all its associated contact 
details, notes, pictures, documents and so on and having it related (or 
linked) to an individual means you will never have to re-type all the details 
again. Just type the individual name, and select the organization ID 
number (the name will also be shown next to the number for ease of 
identification). All other information linked to the organization such as 
telephone numbers will already be shown, saving you time in having to re-
type it. 
 
And, if you have selected auto enter for the email address of the individual 
in the Preferences layout based on a specified format and known web 
address of the organization, this can be automatically typed for you as 
well. 
 
It is all about saving you time and reducing bad data creeping into your 
records due to bad data entry errors. It can happen to anyone. We are all 
human. However, you definitely have no excuse with SUNRISE Contacts 
2017. This tool will reduce data entry errors and gets faster in adding 
more contacts. 
 
We continue this “auto entering of data to save you time” feature by 
providing you with a powerful postcode lookup tool. No more having to 
figure out the postcode of a suburb or town, painful as can be on various 
occasions. Just enter the suburb (or city) followed by the state in the 
Address fields, and you will discover that the postcode will automatically 
be displayed (assuming you have entered the city and state correctly). If 
the postcode is not correct, click on the Postcode field. It will search for 
other available postcodes for the same city and state (or you can edit the 
postcode.fmp12 lookup database to add new postcode records or update 
existing ones). And if you want your database to do automatic postcode 
lookup in another country, specify the country in the Country field. 
Available postcodes include Australia, United States, United Kingdom and 
Spain, to name a few. 
 
Finally, to ensure you enter data cleanly and with reduced errors, the 
database will eliminate those pesky double space characters, and extra 
carriage return characters where they are not needed (e.g., the first and 
last names). 
 
Want more? When it comes to notes, email messages and calendar item 
text fields, you can specify the type of text cleaning and conversions you 
want performed automatically by the Contacts database (usually activated 
on exiting the field). Go into Preferences section under the Help menu, 
click the Text Cleaner tab, and put an X into the check boxes for the type 
of cleaning and conversion capabilities you want the Contacts database to 
perform. 
 
Now that’s easy! 
 
Sorting records 
Another useful feature of any database system (SUNRISE Contacts 2017 is 



no exception) is the ability to sort records simply by clicking into the field 
you want to sort by and choosing Sort Records under the Records menu. 
Furthermore, you don’t have to repeat the whole process of sorting records 
using the same field. By choosing Sort Records again, you can repeat the 
last sort function. 
 
Needless to say, if you want to unsort your records, choose Unsort in the 
Records menu. 
 
NOTE: In list layouts (where the records are shown in a compact 
spreadsheet-like way), you can sort fields by clicking on the field title (or 
header) name at the top of each column. As an additional feature, some 
list layouts can display different fields. To see these fields, press the 
Option key and click on the field title name. 
 
Navigating records, layouts and fields 
SUNRISE Contacts 2017 will sometimes provide multi-functional navigation 
buttons to help you navigate across not just records, but also calendar 
dates (remember to press the Option key when clicking the buttons in the 
calendar layout). In the layout navigation buttons, press the Option key as 
you click on the buttons to take you to the first or last layout in the group. 
Press Ctrl and Option keys while clicking to take you to another layout 
group. 
 
NOTE: For iPad, iPhone and Android users, use the three-finger tap on the 
navigation header region to take you to the Menu layout. From there you 
can access any layout group, whether it be the Address Book, Notes, 
Calendar or anything else. 
 
To switch between List (for a big picture look at many records as a means 
of detecting large-scale trends in all your data or to find specific data 
more quickly by scanning groups of records at once) and Form (for a more 
focused and detailed look at a specific record) design layouts, click the 
button on the far left of the Navigation buttons. Or press the same key 
combination for the layout group a second time to enter the List layouts, 
and vice versa. 
 
Account names 
SUNRISE Contacts comes with pre-defined account names. These are: 
 
Account 1 (Default login) 
Username: Owner 
Password: owner 
 
Account 2 
Username: Admin 
Password: admin 
 
Account 3 
Username: FileMaker Guest 
Password: guest 
 



Account 4 (External Guests) 
Username: [User’s PC login name] 
Password: [User’s PC login password] 
 
Except for Account 4, all other accounts can have their passwords changed 
for greater security. And the further down the account names list you go, 
the greater the restrictions in what you can do with the contacts and 
lookup databases. 
 
Anything else? 
You can be sure to find numerous other features and layouts when 
exploring SUNRISE Contacts 2017. All should be fairly straightforward to 
use. Try them out and see how they can make your life easier in getting 
things done. 
 
Enjoy! 
  


